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1 About Case Notebook Administration 

Case Notebook legal case management software serves as a centralized, electronic case file where entire teams can enter and 
share key facts, insights, notes, documents, main characters, evidence, legal research, and more. Case Notebook Administration is 
used in conjunction with the Case Notebook products to manage user and case repository access.  

Navigate help topics using the help buttons provided on screens in Case Notebook or use the Contents tab to review topics in the 
help. Click the Search or Index tabs to search for help topics. 

Logging into Case Notebook Administration 
After installing Case Notebook Administration software, you will need your authorized credentials to log in. 

1. Enter your Username.  
2. Enter your Password.  
3. Click Login.  

 Note: Passwords are case-sensitive. 

If you are not a user in Active Directory mode and you happen to forget your password, you can use the Forgot Password option for 
further assistance. 

If you are a user in Active Directory mode and happen to forget your password, the Forgot Password option will not be available to 
you. Contact your internal administrator for further assistance. If you cannot provide the correct password, then you will need to 
call Customer Technical Support 1-800-290-9378 for assistance with resetting your password. You can also visit the Case 
Notebook customer support page at  https://legal.thomsonreuters.com/en/support/case-notebook.  

Getting Started with Case Notebook Administration 
Case Notebook Administration requires a licensed installation of Case Notebook Repository in order to run. Features in Case 
Notebook Administration differ when working with Case Notebook vs. Case Notebook (Transcripts). 

1. Set up repositories. 
2. Create user accounts (see “Creating, Editing, and Deleting Users” on page 17 for more information).  
3. Optionally, create groups to organize or categorize users (see “Creating and Deleting Groups” on page 18 for more 

information). 
4. Create or add cases to the repository (see “Working with Cases” on page 5 for more information). 
5. Provide access to users or groups to case data (see “Working with Users and Groups” on page 10 for more information). 
6. Create reports to audit administrator activities and review user data such as assigned case permissions and offline users 

(see “Working with Reports” on page 25 for more information). 

Case Notebook Suite 
Case Notebook is an electronic organizer and deposition tool for saving and working with important documents, research, and 
transcripts. Case Notebook has a number of software tools comprising the suite of Case Notebook products. 

Version number, copyright information, support contact information, and registration information for your copy of Case Notebook 
can be viewed by clicking the Help menu and selecting About Case Notebook Administration. 

CASE NOTEBOOK (TRANSCRIPTS) 

Case Notebook (Transcripts) was formerly known as West LiveNote. This application allows you to view and work with deposition 
transcripts. 

CASE NOTEBOOK REPOSITORY 

For Case Notebook or Case Notebook (Transcripts) administrators, Case Notebook Repository allows multiple users to have access 
to Case Notebook or Case Notebook (Transcripts) cases and is managed by Case Notebook Administration. Case Notebook 
Repository is installed on a server that is accessible to all Case Notebook or Case Notebook (Transcripts) users and administrators. 

CASE NOTEBOOK ADMINISTRATION 

For Case Notebook or Case Notebook (Transcripts) administrators. Case Notebook Administration is used in conjunction with Case 
Notebook Repository to manage access to Case Notebook or Case Notebook (Transcripts) cases that are shared across a network. 
Case Notebook Administration is installed on each administrator's computer and connects to SQL server. 

https://legal.thomsonreuters.com/en/support/case-notebook
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CASE NOTEBOOK PORTAL 

For current subscribers to Case Notebook. Case Notebook Portal allows you to build custom web parts into your matter-centric 
intranet pages and enable intranet users to view and open Case Notebook materials. 

CASE NOTEBOOK RAS (REMOTE ACCESS SERVER) 

Case Notebook RAS provides remote access to your Case Notebook or Case Notebook (Transcripts) cases via the Internet. 

LIVENOTE VIDEOSITE 1.0 

For current subscribers to Remote Video Sharing. VideoSite is the software received with a Remote Video Sharing subscription and 
works with Case Notebook or Case Notebook (Transcripts) to provide remote access to streaming videotaped recordings of a 
deposition. 

LIVENOTE SERIAL WRITER 

Serial Writer allows you to test the serial connection of a computer running LiveNote, Case Notebook, or Case Notebook 
(Transcripts). 

LIVENOTE STREAM MANAGER 

For court reporters using LiveNote Stream. LiveNote Stream Manager allows court reporters to provide live audio, video, and real-
time deposition text to authorized participants connected to the Internet and LiveNote Stream. 
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2 The Case Notebook Administration 
Interface 

The Case Notebook Administration interface includes tabs on the bottom left for cases, users, and groups. Select a tab to display 
the table of information associated with that tab. The Active View pane on the right displays details about the information selected 
from that left pane. 

At the top of the interface is a toolbar providing access to common tasks. Click the View menu and select an option to turn the 
display of the toolbar, status bar, and inactive users on or off. Refresh the display using the View menu, Refresh option or the 

Refresh all views ( ) toolbar button. You can set up automatic refresh by clicking the Options menu, selecting Default Options, 
and setting the Automatically Refresh option. 

 

Access detailed information and change the content of the Active View pane by right-clicking on a user, group, or case in the Active 
View and selecting Active View. 

Setting Options 
Set default repository and administrative options by clicking the Options menu and selecting Default Options. 

• By default, new cases are created as unmanaged cases. If you want new cases to default to managed case types, select 
Default New Cases to Managed. 

• To enable users to authenticate using their Windows password, select Authenticate users against Active Directory (see 
"Working with Active Directory Authentication" on page 7 for more information). One of the following messages is 
displayed: 

o "WARNING: Enabling Active Directory authentication means users must use their Active Directory username and 
password to access Westlaw Case Notebook and/or Westlaw Case Notebook Administration. Enabling Active 
Directory authentication without first configuring your repository could result in users not having access to Westlaw 
Case Notebook and/or Westlaw Case Notebook Administration. Do you want to continue?" Click Yes to continue. 

o "WARNING: The administrative user ‘your username’ does not currently exist in Active Directory. Enabling Active 
Directory Authentication means an Active Directory username and password are required to access the Repository. 
Because you do not have an Active Directory username and password, you will be unable to access Repository and 
Westlaw Case Notebook Administration. Do you want to continue?" Click No, add your username and password to 
Active Directory, create an account for yourself with the same username and password used in Case Notebook 
Administration, and return to the Case Notebook Administration Default Settings to enable Active Directory 
authentication. If you do not do this, the next time you log on to Case Notebook Administration, you will be locked 
out. 

o "ERROR: Enabling Active Directory authentication means an Active Directory username and password are required 
to access the Repository. Currently, no Westlaw Case Notebook administrators have an Active Directory username 
and password. Create a Westlaw Case Notebook administrator username and password for a user in Active 
Directory and enable Active Directory authentication." Add your username and password to Active Directory, create 
an account for yourself with the same username and password used in Case Notebook Administration, and return 
to the Case Notebook Administration Default Settings to enable Active Directory authentication. 
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 Important! The Active Directory service cannot be reached if you log in as a local user (with your local credentials). 
You must log in as a domain user in order to reach the Active Directory service and enable Active Directory 
authentication. 

• Each time a connection to the repository is made, a session is initiated. By default, the repository Sessions timeout after 
600 seconds of inactivity (after closing the case). Setting a longer timeout may be useful for slow or intermittent 
connectivity issues. 

• Select When exporting user list, include seat information to include available seat information when using the File menu, 
Export Group/User List option. For more information, see "About Seats" on page 12. 

• By default, the Case Notebook Administration views are not refreshed automatically. Manually refresh the display using 

the View menu, Refresh option or by clicking the Refresh all views ( ) toolbar button. Set Case Notebook Administration 
to automatically refresh by selecting Automatically Refresh and setting a time in the field provided. 

Creating Security Question and Answer Pairs 
Security questions provide an alternative way to log in to Case Notebook Administration should you happen to forget your 
password. This feature is only available to users that are not in Active Directory mode.  

When you log in to Case Notebook Administration for the first time, you will be prompted create security question and answer 
pairs. Click Yes and follow the instructions to create your security question and answer pairs.  

If you do not wish to create your security question and answer pairs, click No. Case Notebook Administration will prompt you to 
create security question and answer pairs every time you log in. To stop these prompts from displaying every time you log in, check 
Don’t show me this again and click No.  

To create security question and answer pairs at your own convenience:  

1. Click the Users tab.  
2. Right-click on your user name.  
3. Select Edit from the menu.  
4. Click Edit Security Questions.  
5. Follow the instructions on the Security Questions dialog window.  

Once you create the security question and answer pairs, you will have the ability to use the Forgot Password option (only available 
to users that are not in Active Directory mode) to log in to Case Notebook Administration.  

You can create up to 5 security question and answer pairs. All security question and answer pairs you have created will be 
displayed on the Security Questions dialog window when you click Forgot Password. You must answer all security question and 
answer pairs correctly in order to log in to Case Notebook Administration.  
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3 Working with Cases 

A case refers to a collection of content types. A repository refers to the storage location of the case files. Cases in repositories are 
referred to as secure cases. Click the Cases tab on the bottom left to display the Cases list. Case Notebook Administration displays 
the following case types on the Cases tab: 

• Managed cases : These are managed by an administrator using Case Notebook Administration. Only users authorized 
by administrators have access to these cases. User permissions are set by administrators (see "About User Types and 
Permissions" on page 10 for more information). 

• Unmanaged cases : Unmanaged cases are accessible by any user with access to the repository where the case resides. 

Case Notebook Administration lists all of the cases for the open repository in the Cases list. Click the Cases tab on the bottom left 
to display the Cases list. Quickly switch the content in the Active View by right-clicking on a user, group, or case in that view and 
selecting Active View. 

• Click on any column heading in the Cases list to sort the list in ascending or descending order by that column. 
• Double-click on a case in the Cases list to display the Active Case View in the right pane. The Active Case View displays the 

name of the case, the case type, groups and users assigned to the case, users to which the user has been assigned, cases 
the user has replicated offline, and cases currently open by users.  

• Right-click on a case in the Active User View and select Print Permissions to print the permissions information for all users 
who have access to a case (see "Printing User Permissions" on page 12 for more information). 

• Create new users using the New Case ( ) toolbar button. For detailed instructions on creating cases, see "Creating, 
Importing, and Editing Cases" on page 5 for more information. 

• To edit existing case information, right-click on the case in the Cases list and select Edit. 
• To import users into Case Notebook Administration from a .csv file, click the Repository menu and select an Import 

Repository option. 

Moving Cases 
To move a case to another location, right-click on the case in the Cases list and select Move. Select a new location for the case and 
click Save. 

Deleting Cases 
To delete a case, right-click on the case in the Cases list and select Delete. Deleting a case does not affect the users or groups 
assigned to that case. 

Changing the Owner of Annotations, Auto Tags, and Key Facts 
If an owner is no longer working on a case, change the owner. Select the case in the Cases list, click the User menu, and select 
Change Ownership.  

Exporting the Cases List 
Save the Cases list names and paths as a .csv or .txt file. Click the Repository menu and select Export Case List. In the Save as type 
field at the bottom of the save dialog, select a file type, provide a name and browse for a location, then click Save. 

Updating and Rebuilding the Search Index 
To update or rebuild search indexes, right-click on the case in the Case list and select Update Search Index or Rebuild Search 
Index. You can also select a case from the Case list, click the Case menu and click Update Search Index or Rebuild Search Index. 
To save a copy of the messages received when updating or rebuilding, click Copy to Clipboard, then paste the messages into 
another program. The option to copy these messages is only available at this point. You cannot access this option elsewhere in the 
application. 

Creating, Importing, Exporting and Editing Cases 
Click on a case in the Cases list to display the Active Case View in the right pane. The Active Case View displays the name of the 
case, whether the case is managed or unmanaged, groups to which the case belongs, users assigned to the case, users who have 
replicated the case offline, and users who currently have the case open. Quickly switch the content in the Active View by right-
clicking on a user or group in that view and selecting Active View. 
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CREATING NEW CASES 

1. Click the Case menu and select New or click the New Case ( ) toolbar button. 
2. Type a name for the case in the Case Name field and browse for the Case Path. 
3. Select whether or not to make this a Managed case. 
4. Optionally, type information in the Client-Matter and Case Comments fields. 
5. Click OK. The case is added to the Cases list. 

IMPORTING CASES 

You can import cases created in Binder or Case Notebook and therefore convert them from local to secure cases. 

1. Click the Case menu and select Import or click the Import Case ( ) toolbar button. 
2. Click Browse, navigate to, and select the case .lnp file or Binder .pxl file. Click Next. 
3. If the case contains annotations, you will be prompted to select a current user as the author of those annotations. If you 

choose not to assign a current user as author of all the annotations or do not know the author of the annotations, you can 
create a fictitious user (for example, Historical Annotations) to assign as author of the annotations. Click Next. 

4. Type a name for the case in the Case Name field and browse for the Case Path. 
5. Select whether or not to make this a Managed case. 
6. Optionally, type information in the Client-Matter and Case Comments fields. Click Next. 
7. Click Finish. 

Import ing Multiple Cases 

You can batch import several cases at once. You can import a group of cases or import a folder that contains cases. 

1. Click the Case menu and select Batch Import. 
2. Click Add Cases to select one or more case files to import. The following types of case files are available for selection: 
o LiveNote Project Files (*.lnp)  
o Cabinet Files (*.cab). Note: Only (*.cab) cases can be selected for import.  
o LiveNote SR (*.lnt)  
o Binder Project Files (*.pxl) 

Note: You can also click Add folder to select a folder containing the cases you want to import.  
3. Click Next. 
4. If the cases contain annotations, you will be prompted to select a current user as the author of those annotations. If you 

choose not to assign a current user as author of all the annotations or do not know the author of the annotations, you can 
create a fictitious user (for example, Historical Annotations) to assign as author of the annotations. Select Prompt for an 
owner for each case or Use the following owner for all imported cases. Click Next. 

5. Enter the destination location to store the imported cases in the Case Path field, or click Browse to find and select the 
folder. This folder must be a network shared folder that is available to all Case Notebook users that are assigned to the 
case. Click Next. 

6. If you selected Prompt for an owner for each case, you will be prompted to select owners (you can apply the same owner to 
all remaining cases). Click OK to start the batch import .Once the process is complete the Batch Import Results dialog box 
is displayed.  

7. Select Save the import report to save a report of the batch import (this is optional).  
8. Click Finish. If you selected Save the import report, you can now browse for a location to save the batch import report. 

EXPORTING CASES 

You can export (*.cab) cases in their entirety.  

Note: Ensure no users are currently accessing the cases to be exported and no offline copies are outstanding. Cases will not export 
correctly if they are open/in use. 

1. Click the Case menu and select Export or right-click on a case and select Export from the menu.  
2. Enter the destination directory or click Browse to find and select a folder where you want to export the case.  
3. If you don't want to export the flat files in the case, then uncheck Export flat files. This creates an export of only the 

database records. It is a faster way to capture a backup or a copy of the SQL data when you want to move a case 
internally (or make a copy of the case) because the underlying files can be more quickly copied internally across file 
shares. 
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Note: Exporting flat files adds not only the database records for the case, but also the related transcripts, exhibits, 
documents, briefs, pleadings, etc. to the output i.e. the entire contents of \\PathToCaseStorage\CaseName.dir\ are part 
of the export. Use this feature when you want to archive a case completely or send a case to another firm.  

4. Click OK to start the export process.  
5. Once the export process is complete, the Case Export Messages dialog box is displayed which shows the case path, case 

name, and a message on the status of the export. You can click Copy to Clipboard to create and save a copy of this 
information and refer to it at your convenience.  

6. Click OK to close the Case Export Messages dialog box. The case is exported to the selected destination.  

CHANGING CASE DETAILS 

To change the name, path, client-matter, comments, or type (managed or unmanaged) of an existing case, right-click on the case 
in the Cases list and select Edit. 

CHANGING THE OWNER 

If an owner is no longer working on a case, change the owner of annotations, auto tags and key facts. Select the case in the Case 
list, click the User menu, and select Change Ownership.  

Managing User and Group Access to Cases 
Add users or groups to managed cases to grant them access to the case. You can also remove users or groups access to managed 
cases. 

ADDING USERS OR GROUPS TO MANAGED CASES 

Managed cases can only be accessed by the users and groups added to them in Case Notebook Administration. Unmanaged cases 
are accessible by all users by default.  

1. Click the Cases tab. 
2. Double-click on the case you want to edit, the Active Case View displays in the right pane. 
3. Click the Users or Groups tab. 
4. Drag and drop the users or groups into the Active Case View Users or Groups folder. 

 

REMOVING USERS OR GROUPS FROM MANAGED CASES 
1. Click the Cases tab. 
2. Double-click on the case you want to edit, the Active Case View displays in the right pane. 
3. Expand the Users or Groups folder in the Active Case View. 
4. Right-click on the user or group and select Remove from active case. See "Setting Case-Based User Permissions" on 

page 18 for more information. 

Working with Active Directory Authentication 

Active Directory is a directory service that allows users to use network (Windows) user names and passwords to authenticate across 
multiple applications, including Case Notebook. Using Active Directory authentication in Case Notebook Administration is 
optional. 

• Active Directory authentication is not compatible with LiveNote Enterprise Server version 9. 
• Administrators must add their user name and password to Active Directory in order to enable Active Directory 

authentication for other users. 
• Case Notebook users must be listed in Active Directory and know their user names and passwords to authenticate using 

Active Directory. 
• The Case Notebook Admin Tool can be used to schedule automatic updates of groups and users from Active Directory (see 

"Working with the Admin Tool" on page 8 for more information). 

ENABLING ACTIVE DIRECTORY AUTHENTICATION 

Enable Active Directory Authentication by clicking the Options menu, selecting Default Options, and selecting Authenticate users 
against Active Directory. For detailed information on enabling Active Directory Authentication, see "Setting Options" on page 3. 

Important! The Active Directory service cannot be reached if you log in as a local user (with your local credentials). You must log in 
as a domain user in order to reach the Active Directory service and enable Active Directory authentication. 
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IMPORTING USERS AND GROUPS FROM ACTIVE DIRECTORY 
1. Click the Repository menu, select Import Group/User List, and select the Import from Active Directory option to import 

users or groups from Active Directory. 
2. Click Next. 
3. Select a group from the Active Directory group drop-down list. 
4. Click Next. 
5. Select the default user settings to apply to all imported users. 
6. Assign permissions to the users to designate the level of access the users have to a case. 

• Select a User Type from the drop-down list. For detailed information on User Types and their permissions, see 
"User Types" on page 10. 

• Select a User State from the drop-down list. User is active allows the users to access secure cases, provided the 
users have a seat for the product. User is not active prevents the users from accessing secure cases. 

7. Optionally, select to allocate seats. If there are not enough seats, the options will not be available. For more information, 
see "About Seats" on page 12. 

8. Select any Additional User Permissions (see "User Permissions" on page 11 for more information). 
9. Select a default password and set password options. 

10. Click Next, then click Finish. 

Upgrading and Locking Case Versions 

Upgrade a case to match the version of Case Notebook Administrator. Right-click the case and select Upgrade from the drop-
down menu. Alternatively, select a case in the Cases list, click the Case menu, and then select Upgrade from the drop-down menu. 
To upgrade multiple cases or the entire repository, select multiple cases, right-click, and select Upgrade from the drop-down 
menu. Alternatively, select multiple cases in the Cases list, click the Case menu, and then select Upgrade from the drop-down 
menu.  Once you upgrade a case, only users working in that version (or later) of Case Notebook can open and work in that case.  

You can lock a case to its current version of Case Notebook to prevent a user who is working with a later version of Case Notebook 
from upgrading a case to that later version (thereby restricting access to the case to users working in earlier versions). Select the 
cases in the Cases list that you want to lock and check the Version Lock check box next to the case in the list. Version lock is only 
honored by Case Notebook versions 3.6 or later. For example, if a user working in version 3.0 opens a version locked 2.0 case, 
version lock is not honored and the case is upgraded to 3.0. If a user working in version 3.6 or later opens a version locked 2.0 case, 
version lock is honored and the case is not upgraded. 

Working with the Admin Tool 
This is an advanced topic for users with knowledge of working in command line interfaces. Admin Tool is a command line tool that 
allows you to schedule automatic updates of groups and users from Active Directory. You can also specify user settings and assign 
Case Notebook seats using this tool. By default, the Admin Tool is located in the C:\Program Files\Westlaw Case Notebook\Administration 
directory. 

To use the Admin Tool, you create a batch file and then use Windows Scheduled Tasks to implement it. 

SAMPLE BATCH FILE 

This batch file example changes the current directory to the directory of the Admin Tool, launches the Admin Tool, logs in with the 
administrator's user name and password, imports an Active Directory group called "Sales", assigns the users in that group as 
Reader User user types, and assigns a Case Notebook seat to all users in the group. 

@ECHO OFF 

CD C:\Program Files\Westlaw Case Notebook\Westlaw Case Notebook Administration 

ADMINTOOL user1/password1 /USERGROUP:Sales /USERTYPE:ReaderUser /LNSEAT 

CREATING A BATCH FILE 

Create a .bat batch file using any text editor (for example, Notepad). The following switches are available: 

•  username/password - User name and password for the Case Notebook administrator. 
• /SERVER:hostname[:port] - Name and port for the Case Notebook repository. If this parameter is not specified, Admin Tool will 

look for a default repository in the user section of the registry. 
• /USERS - Imports all users in the Active Directory. 



Working with Cases  9 

• /USERGROUP:group1[group2].... - Imports all users in the specified group. Also, a group will be created in the repository that 
corresponds to the Active Directory group. 

• /DEFAULTPASS:pw - Specifies the default password assigned to each user. If the repository is configured to authenticate 
users using Active Directory, this parameter will be ignored. 

• /USERTYPE:ExternalUser|ReaderUser|AuthorUser|EditorUser|PowerUser|CaseManager - Assigns a user type to each user. 
• /ADMINPRIV - Assigns administrator privileges to each user. 
• /REPLICATEPRIV - Assigns replication privileges to each user. 
• /POWEREDITORPRIV - Assigns power editor privileges to each user. 
• /LNSEAT - Allocates a LiveNote seat to a user if a seat is available. 
• /LNRASWEBSEAT - Allocates RAS Web seat to a user if seat is available. 
• /d - Disables user in repository when Active Directory is updated if user is disabled in Active Directory. 
• /c - Imports all user names from Active Directory in lower case; users must use all lower case when logging on. 

SCHEDULING TASKS FROM A BATCH FILE 
1. Click the Windows Start menu and type Schedule Tasks into the Search programs and files field. 
2. Click the Schedule Tasks option from the list. 
3. Click Create Basic Task from the Actions pane on right-side of the application. 
4. Type a name and description for the task and click Next. 
5. Select a frequency for which to run the task and click Next. 
6. If required, enter additional frequency information and click Next. 
7. Select Start a program and click Next. 
8. Browse for and select the .bat file you created, then click Finish. 
9. Double-click on the task you just created, select Run with highest privileges, and click OK. 

10. Close the Schedule Tasks application. 

Migrating Cases 

You can migrate cases between repositories.  

1. Click the Case menu and select Migrate. The Please Select Cases for Migration dialog box is displayed. 
2. Select the case for migration (use Ctrl+Shift to select multiple cases) and click Migrate. The case migration process 

begins.  
3. Once the case migration process is complete, the Case Migration Messages dialog box shows the migration status for the 

cases.  

Note: When repositories are migrated, you have the option to proceed with case migration immediately (once the repository 
migration process is successfully done) by clicking Yes on the success message dialog box. See “Migrating Repositories” on page 
23 for more information.  

Important! It is strongly suggested that you do the case migration as soon as possible when repositories are migrated.  

 

mk:@MSITStore:C:%5CUsers%5CMadhavi%5CDesktop%5CWork%20in%20Progress%5CCase%20Notebook%5CHelp%5CHelp%20Source%5C5.8%5CCase%20Notebook%20Admin%5COutput%5COutput%5CWestlaw-Case-Notebook-Administration%5CWestlaw-Case-Notebook-Administration.chm::/Cases%20and%20Repositories/Migrating%20Repositories.htm
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4 Working with Users and Groups 

Case Notebook Administration lists all of the users for the open repository in the Users list. Click the Users tab on the bottom left 
to display the Users list. Organize numerous users into groups then add groups to cases as opposed to adding individual users one 
at a time to a case. Click the Groups tab on the bottom left to display the Groups list. Quickly switch the content in the Active View 
by right-clicking on a user, group, or case in that view and selecting Active View. 

Working with Users 
• Click on any column heading in the Users list to sort the list in ascending or descending order by that column. 
• Double-click on a user in the Users list to display the Active User View in the right pane. The Active User View displays the 

name of the user, whether the user is active ( ) or deactivated ( ), groups to which the user belongs, cases to which the 
user has been assigned, cases the user has replicated offline, and cases currently open by the user.  

• Right-click on a user in the Active User View and select Print to print the user account information. 

• Create new users using the Add User ( ) toolbar button. For detailed instruction on creating users, see "Creating New 
Users" on page 17. 

• To edit existing users, right-click on the user in the Users list and select Edit. 
• To import users into Case Notebook Administration from a .csv file, click the Repository menu, select Import Group/User 

List, and select the Import from file option. 
• To import users from Active Directory (see "Working with Active Directory Authentication" on page 7 for more information), 

click the Repository menu, select Import Group/User List, and select the Import from Active Directory option. 
• To activate, deactivate, or delete one or more users, select the users in the Users list, right-click, and select Activate, 

Deactivate, or Delete (see "Activating, Deactivating, and Deleting Users" on page 18 for more information).  

Working with Groups 
• Click on a group in the Groups list to display the Active Group View in the right pane. The Active Group View displays the 

name of the group, cases assigned to the group, and users in the group. 

• Create new groups using the New Group ( ) toolbar button. For detailed instruction on creating groups, see "Creating 
New Groups" on page 18. 

• To change the name of an existing group, right-click on the group in the Groups list and select Edit. 
• To import groups into Case Notebook Administration from a .csv file, click the Repository menu, select Import Group/User 

List, and select the Import from file option. 
• To import groups from Active Directory (see "Working with Active Directory Authentication" on page 7 for more 

information), click the Repository menu, select Import Group/User List, and select the Import from Active Directory option. 
• To copy or create a new group from an existing group, right-click on the group in the Groups list and select Create Copy. To 

then change the name of that group, right-click on the copied group in the Groups list and select Edit. 
• To delete a group, right-click on the group in the Groups list and select Delete (see "Deleting Groups" on page 19 for more 

information). 
• Add users or cases to existing groups by dragging and dropping them into the Users or Groups folder in the Active Group 

View (see "Adding Users or Cases to Existing Groups" on page 19 for more information). 
• Remove users or cases from existing groups by right-clicking on the user or case in the Active Group View and selecting 

Remove from Active Group (see "Removing Users or Cases from Groups" on page 19 for more information). 

About User Types and Permissions 
When you add a user via Case Notebook Administration, you assign seats, a user type, a user state, and permissions to the user for 
managed cases. 

USER TYPES 

User Types designate the level of access a user has to a case. Types available include: 

External User: External Users have the lowest level of access to cases. (For example, you may want to assign External User status 
to clients or experts who are not a part of the organization.) External Users can: 

• View transcripts, documents, pleadings, research files, linked documents, and videotaped depositions. 
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• Search the full text of transcripts and linked documents and print them. 
• Set options for Case Notebook or RAS. 

Reader User: Reader Users can perform all External User tasks. In addition to the External User tasks, Reader Users can also: 

• View all annotations, Issue Marks, and Quick Marks. 
• View and print reports. 
• Search annotations. 

Author User: Author Users can perform all Reader User tasks. Offline changes made by Author Users are replicated back to the 
network case, with the exception of changes to Auto Tags. In addition to the Reader User tasks, Author Users can also: 

• Create annotations, Issue Marks, and Quick Marks. 
• Edit annotations. 
• Create, edit, and delete new issues in cases that have been replicated offline. 
• Cut, paste, and delete annotations and Quick Marks in cases that have been replicated offline. 

Editor User: Editor Users can perform all Author User tasks. Offline changes made by Editor Users are replicated back to the 
network case, with the exception of changes to Auto Tags. In addition to the Author User tasks, Editor Users can: 

• Edit and delete annotations, Issue Marks, Quick Marks, key facts, and reports created by others when working on an offline 
case. 

• Cut, paste, and delete annotations and Quick Marks created by other users. 
• When working on a network case, Editor Users cannot edit or delete annotations created by another user who has 

replicated the case offline. 

Power User: Power Users can perform all Editor User tasks. Power Users can also: 

• Create and manage transcripts, documents, pleadings, research files, and groups. 
• Open a network case and connect to a real-time deposition, then manage the case index and thesaurus. 
• When working on a network case, Power Users cannot edit the annotations created by another user who has replicated the 

case offline. 
• When working on an offline case, Power Users cannot edit annotations created by other users; create, edit, or delete 

transcript groups; edit the properties of existing transcripts; or delete existing transcripts. 

Case Manager: Case Managers manage all aspects of a case that affect all users. All users are automatically given Case Manager 
status in unmanaged cases, regardless of their user type in managed cases. Case Managers can: 

• Create and manage issues, annotations, Quick Marks, and Auto Tags. 
• Edit case properties. 
• Manage custom categories. 
• Create and delete issues in cases that have been replicated offline. 

USER PERMISSIONS 

Additional user permissions can be assigned when creating a new user or editing an existing user. For more information, see 
"Creating, Editing, and Deleting Users" on page 17. You can also customize access for a user for a specific case (see "Setting Case-
Based User Permissions" on page 18 for more information). 

Administrative Privileges: Administrative privileges allow the user to use Case Notebook Administration. For example, you may 
want to give administrative privileges to litigation support or technical staff. Administrative privileges allow users to: 

• Create, import, and delete secure cases. 
• Create, manage, and delete user accounts. 
• Assign users to cases and set case-specific permissions. 
• Allocate seats. 
• Replicate secure cases offline (creating a local copy) or to the network (merging an offline copy of a case with a network 

copy of a case). 

Power Editor: This permission is available only when the user has a case replicated offline and is only available for managed cases. 
It enables the user to modify others user's annotations, Quick Marks, outlines, and Transcript Summaries. When a Power Editor 
replicates a case back to the network, changes to that data overrides the existing data. A Power Editor can only modify current 
data, new data created when a user is offline is not affected. Note, assign this permission with extreme caution. The work product 
of other users may be lost when replicating the case back to the network. 
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Replicate Case: This allows the user to replicate cases offline. It is selected by default. You can remove this privilege for all or only 
certain cases. 

PRINTING USER PERMISSIONS 

Print permissions for all users who have access to a case for easy viewing or sharing. 

1. Click the Cases tab. 
2. Select a case from the Cases list. 
3. Right-click on the case and select Print Permissions or click the Report menu and select Case Permissions. 

For more information, see “Adding Users or Groups to Managed Cases" on page 7 and "Removing Users or Groups from Managed 
Cases" on page 7. 

About Seats 
Users must be assigned a seat to access secure cases. Seats are obtained when you purchase Case Notebook or Remote Access 
Server (RAS) and become available when you license your secure cases repository. When you create a user account, the user is 
automatically allocated a seat for Case Notebook or RAS if available. Only users who have been assigned a seat can access secure 
cases. 

The number of seats available and seats allocated are displayed in the associated column headings in the Users list (click the 
Users tab, expand the Westlaw Case Notebook Seat or RAS Web Seat columns). 

You can reassign seats when there are changes in staff and you can purchase more seats when no seats are available. To reassign 
the license for a seat or purchase new seats, call Customer Technical Support at 1-800-290-9378. You can also visit the Case 
Notebook customer support page at  https://legal.thomsonreuters.com/en/support/case-notebook. 

ASSIGNING, REASSIGNING, AND REMOVING SEATS 

When you create a user account, the user is automatically allocated a seat if any are available (see "Creating New Users" on page 
17 for more information). You may, however, need to assign, reassign, or remove seats after you create a user account. When you 
deactivate or delete a user, their seats are automatically removed from them (see "Activating, Deactivating, and Deleting Users" on 
page 18 for more information). 

1.  Click the Users tab. 

 

2. Select or clear the Westlaw Case Notebook Seat or RAS Web Seat options to assign, reassign, or remove a user's seat. 

ALLOCATING/UNALLOCATING MULTIPLE SEATS AT ONE TIME 
1. Click the Users tab. 
2. Select the users from the Users list, right-click, point to Allocate/Unallocate Seat, and select an option. 

https://legal.thomsonreuters.com/en/support/case-notebook
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5 Online and Offline User Rights 

Case Notebook Administrators assign permissions to users to enable them to carry out additional tasks. The tables below describe 
rights associated with different User Types. See "About User Types and Permissions" on page 10 for more information. 

ONLINE USERS 

Task External Reader Author Editor Power Case 
Manager 

Create/print case or full text search reports Yes Yes Yes Yes Yes Yes 

Create/print reports of annotations, notes, 
attachments, issues, quick marks, characters, 
auto tags, transcript summaries, designations, 
and key facts 

No Yes Yes Yes Yes Yes 

Edit the properties of issues No No No No No Yes 

Edit the properties of transcripts, documents, 
pleadings, research, custom category files 

No No No No Yes Yes 

Edit properties of their own outlines No No Yes Yes Yes Yes 

Edit outline properties of others No No No Yes Yes Yes 

Connect to new Realtime No No Yes Yes Yes Yes 

Update transcripts No No No No Yes Yes 

Add auto tags No No No No Yes Yes 

View/replicate issues No Yes Yes Yes Yes Yes 

View outlines, transcript summaries, 
designation types 

No Yes Yes Yes Yes Yes 

View/replicate annotations, key facts, 
characters 

No Yes Yes Yes Yes Yes 

Create issues, create and modify designation 
types 

No No No No No Yes 

Create annotations, key facts, characters, 
outlines, transcript summaries, designations, 
data group 

No No Yes Yes Yes Yes 

Add attachments to annotations No No Yes Yes Yes Yes 

Delete issues, designation types No No No No No Yes 
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Task External Reader Author Editor Power Case 
Manager 

Delete/modify characters/smart tags No No Yes Yes Yes Yes 

Delete own key facts, outlines, transcript 
summaries 

No No Yes Yes Yes Yes 

Modify own annotations, key facts, outlines, 
transcript summaries, designations 

No No Yes Yes Yes Yes 

Modify others key facts, outlines, transcript 
summaries  

No No No Yes Yes Yes 

Modify own annotations while offline (including 
cut and paste) 

No No Yes Yes Yes Yes 

Modify designation video positions No Yes Yes Yes Yes Yes 

Delete own annotations, quick marks, 
designations 

No No Yes Yes Yes Yes 

View transcripts, documents, pleadings, 
research, custom category files 

Yes**  

 

Yes Yes Yes Yes Yes 

Full text search Yes Yes Yes Yes Yes Yes 

Create transcripts, documents, pleadings, 
research, custom category files 

No No No No Yes Yes 

Edit case properties No No No No No Yes 

Manage noise words No No No No Yes Yes 

Delete transcripts, documents, pleadings, 
research, custom category files 

No No No No Yes Yes 

Delete others, key facts, outlines, transcript 
summaries 

No No No Yes Yes Yes 

Delete others annotations, quick marks, 
designations 

No No No Yes Yes Yes 

Edit others annotations, quick marks, 
designations (cut, paste, change properties) 

No No No Yes Yes Yes 

Delete auto tags No No No No Yes Yes 

Manage custom categories  No No* No* No* No* Yes 
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Task External Reader Author Editor Power Case 
Manager 

Manage custom properties  No No No No No Yes 

Move data  No No No No No Yes 

*Permissions must be assigned by the Case Notebook Administrator. 

** Custom category is not blocked. 

 

OFFLINE USERS 

Task External Reader Author Editor Power Case 
Manager 

Create/print case or full text search reports Yes Yes Yes Yes Yes Yes 

Create/print reports of annotations, notes, 
attachments, issues, quick marks, characters, auto 
tags, transcript summaries, designations, and key 
facts 

No Yes Yes Yes Yes Yes 

Edit the properties of issues No No No No No No 

Edit the properties of transcripts, documents, 
pleadings, research, custom category files 

No No No No No No 

Edit properties of their own outlines No No Yes Yes Yes Yes 

Edit outline properties of others No No No No* No* No* 

Connect to new Realtime No No Yes Yes Yes Yes 

Update transcripts No No No No Yes Yes 

Add auto tags No No No No Yes Yes 

View/replicate issues No Yes Yes Yes Yes Yes 

View outlines, transcript summaries, designation 
types 

No Yes Yes Yes Yes Yes 

View/replicate annotations, key facts, characters No Yes Yes Yes Yes Yes 

Create issues, create and modify designation types  No No No No No Yes 

Create annotations, key facts, characters, outlines, 
transcript summaries, designations, data groups 

No No Yes Yes Yes Yes 
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Task External Reader Author Editor Power Case 
Manager 

Add attachments to annotations No No Yes Yes Yes Yes 

Delete issues, designation types No No No No No No 

Delete/modify characters, smart tags No No No No No No 

Delete own key facts, outlines, transcript summaries No No No No No No 

Modify own annotations, key facts, outlines, 
transcript summaries, designations 

No No Yes Yes Yes Yes 

Modify others key facts, outlines, transcript 
summaries 

No No No No* No* No* 

Modify own annotations while offline (including cut 
and paste) 

No No Yes Yes Yes Yes 

Modify designation video positions No Yes Yes Yes Yes Yes 

Delete own annotations, quick marks, designations No No Yes Yes Yes Yes 

View transcripts, documents, pleadings, research, 
custom category files 

Yes** Yes Yes Yes Yes Yes 

Full text search Yes Yes Yes Yes Yes Yes 

Create transcripts, documents, pleadings, research, 
custom category files 

No No No No Yes Yes 

Edit case properties No No No No No No 

Manage noise words No No No No No No 

Delete transcripts, documents, pleadings, research, 
custom category files 

No No No No No No 

Delete others, key facts, outlines, transcript 
summaries 

No No No No No No 

Delete others annotations, quick marks, 
designations 

No No No Yes, if 
Power 
Editor* 

Yes, if 
Power 
Editor* 

Yes, if 
Power 
Editor* 

Edit others annotations, quick marks, designations 
(cut, paste, change properties) 

No No No Yes, if 
Power 
Editor* 

Yes, if 
Power 
Editor* 

Yes, if 
Power 
Editor* 

Delete auto tags No No No No Yes Yes 
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Task External Reader Author Editor Power Case 
Manager 

Manage custom categories  No No No No No No 

Manage custom properties  No No No No No No 

Move data No No No No No No 

*A user must be Editor or above to become a Power Editor. Power Editors have more discretion when working offline. For example, 
they can edit outlines, transcript summaries and designations, annotations, and key facts of others when offline and they can 
delete others annotations, including quick marks and designations when offline. 

** Custom category is not blocked. 

Creating, Editing, and Deleting Users 
Click the Users tab on the bottom left to display the Users list. Click on any column heading to sort the list in ascending or 
descending order by that column.  

Click on a user in the list to display the Active User View in the right pane. The Active User View displays the name of the user, 
whether the user is active ( ) or deactivated ( ), groups to which the user belongs, cases to which the user has been assigned, 
cases the user has replicated offline, and cases currently open by the user. Right-click on a user in the Active User View and select 
Print to print the user account information. Quickly switch the content in the Active View by right-clicking on a group or case in that 
view and selecting Active View. 

CREATING NEW USERS 

1. Click the User menu and select New or click the Add User ( ) toolbar button. 
2. Type the user details in the fields provided. 

 

3. Select a password option. 
4. Assign permissions to the user to designate the level of access a user has to a case. 

• Select a User Type from the drop-down list. For detailed information on User Types and their permissions, see 
"User Types" on page 10. 

• Select a User State from the drop-down list. User is active allows the user to access secure cases, provided the user 
has a seat for the product. User is not active prevents the user from accessing secure cases. 

5. Select any Additional User Permissions (see "User Permissions" on page 11 for more information). 



18  Online and Offline User Rights  

6. Optionally, select to allocate seats. If there are not enough seats, the options will not be available. For more information, 
see "About Seats" on page 12. 

EDITING EXISTING USERS 

To edit an existing user, right-click on the user in the Users list and select Edit. 

To set User Types for users, select the users from the Users list, right-click, point to Set user type, and select a user type (see "User 
Types" on page 10 for more information). 

ACTIVATING, DEACTIVATING, AND DELETING USERS 

The Active User View displays active ( ) and deactivated ( ) users. To show or hide deactivated users, click the View menu and 
uncheck Inactive Users. 

Deactivating a user removes that user's access to secure cases but retains the user in the Users list. When you deactivate or delete 
a user, their seats are automatically removed from them (see "About Seats" on page 12 for more information). Deactivated or 
deleted user's ownership of Annotations, Auto Tags, Key Facts, Outlines, or Transcript Summaries is not automatically removed. To 
activate, deactivate, or delete one or more users, select the users in the Users list, right-click, and select Activate, Deactivate, or 
Delete. 

Setting Case-Based User Permissions 
Customize access for one or more users for a managed case that is particularly sensitive or requires strict user access. For detailed 
information on User Types, see "User Types" on page 10. 

To customize access for a user for a specific case, that user must be added to the case as an individual, not as a member of a 
group. 

1. Click the Cases tab. 
2. Double-click on the case you want to edit, the Active Case View displays in the right pane. 
3. Expand the Users folder in the Active Case View. 
4. To change just the User Type, right-click on the user, point to Set user type, and select a User Type to apply to this user for 

this case only. To change the user type and permissions, right-click on the user, select Edit, and select the User Type and 
Permissions for this user for this case only (see "About User Types and Permissions" on page 10 for detailed information). 

Changing the Replication Status of a Case for a User 
Case Notebook users can replicate a case offline for use off the network. Users can also replicate the case back to the network, or 
online. In some situations, such as when a computer is stolen or has technical problems, you may need to set a case for a user as 
replicated to offline or to the network. To set a case as replicated to offline or to the network, change the case user to offline or 
online status. Note that when a user replicates a case offline, that user's annotations in the case are not available to other users on 
the network. Other users can run reports and search and view the annotations of the offline user but cannot edit or delete them. 

1. Click the Cases tab. 
2. Double-click on the case you want to edit, the Active Case View displays in the right pane. 
3. Click the Users tab. 
4. Right-click on the user and select Mark this user offline in the repository or Mark this user online in the repository. 

Creating and Deleting Groups 
Organize numerous users into groups then add groups to cases as opposed to adding individual users one at a time to a case. 
When you add a group via Case Notebook Administration, you provide a group name, add users to the group, and add cases to the 
group. Click the Groups tab on the bottom left to display a list of groups. 

Click on a group in the list to display the Active Group View in the right pane. The Active Group View displays the name of the 
group, cases assigned to the group, and users in the group. Quickly switch the content in the Active View by right-clicking on a user 
or case in that view and selecting Active View. 

Groups utilize the individual permissions of the users that belong to them, they do not have their own permissions. If you change 
permissions for users, that change follows those users in all groups to which they belong. 

Creating New Groups 

1. Click the Group menu and select New or click the New Group ( ) toolbar button. 
2. Type a name for the group and click OK. The group is added to the Groups list and the details are displayed in the Active 

Group View in the right pane. 
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3. Click the Users tab. Select the users from the Users list that you wish to add to the group and either drag and drop the 
users into the Active Group View Users folder in the right pane or right-click on the users and select Add to active group. 

4. Click the Cases tab. Select the managed cases from the Cases list that you wish to assign to the group and drag and drop 
the cases into the Active Group View Cases folder in the right pane or right-click on the managed cases and select Add to 
active group. 

Deleting Groups 
To delete a group, right-click on the group in the Groups list and select Delete. Deleting a group does not affect the users or cases 
assigned to that group. They still exist. If you need to create a new group to ensure access to cases by specific users or add users 
individually to a case, you can still do so. 

Customizing Groups 
Add users or cases to existing groups. 

ADDING USERS OR CASES TO EXISTING GROUPS 
1. Click the Groups tab. 
2. Double-click on the group you want to edit to display the Active Group View in the right pane. 
3. Click the Cases or Users tab. 
4. Drag and drop the cases or users into the Active Group View Cases or Users folder. 

REMOVING USERS OR CASES FROM GROUPS 
1. Click the Groups tab. 
2. Double-click on the group you want to edit to display the Active Group View in the right pane. 
3. Expand the Cases or Users folder in the Active Group View. 
4. Right-click on the case or user and select Remove from active group. 

Exporting and Importing Users and Groups Lists 
Save the Users and Groups list as a .csv file and import batch files containing user accounts and groups into Case Notebook 
Administration. 

EXPORTING USERS AND GROUPS LISTS 

Click the Repository menu and select Export Group/User List. Provide a name and browse for a location, then click Save. The 
exported file provides data such as user ID, encrypted password information (not readable), the last and first name of the user, the 
user type, and privilege information (displayed as 0 for no and 1 for yes) for all users. The data contained in the first two rows of the 
exported file can be ignored. The third row is the header row which describes the columns for user rows. For groups, the group 
name and user IDs for users belonging to that group are provided.  

This is an example of an exported user with details: 

  

• "belindar" is the user ID. 
• "0000..." is the Case Notebook version GUID. 
• "Richardson" is the user's last name. 
• "Belinda" is the user's first name. 
• "e8yqy..." is the encrypted password. 
• "Reader User" is the user type. 
• 0 = no administrative privileges. 
• 1 = can replicate. 
• 0 = no power editor permission. 
• 1 = can change password. 
• 0 = is not required to change password upon next login. 
• 0 = does not have Case Notebook seat. (The setting to include this information in the report is available by clicking the 

Options menu and selecting Default Options.) 
• 0 = does not have RAS seat. (The setting to include this information in the report is available by clicking the Options menu 

and selecting Default Options.) 
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CREATING A BATCH FILE TO SHARE USERS OR GROUPS 

Manually create a file containing user information and import it into Case Notebook Administration. Create a .csv file in the 
following format for import into Case Notebook Administration. 

Adding Users 

In the first line of the document, type password,plain to indicate the user's passwords will be in plain text format (as opposed to 
encrypted). Each user account contains the following fields (where 1 is yes and 0 is no) with quotes around each field, commas 
separating fields, and no spaces: 

USER,<user ID>,<blank>,<lastname>,,<firstname>,<password>, 
<user type>,<administrator 1 or 0>,<can replicate 1 or 0>, 

<power editor 1 or 0>,<can change password 1 or 0>, 
<must change password 1 or 0>,<Case Notebook seat 1 or 0> 

For example: 

USER,belindar,,Richardson,Belinda,changepassword,Reader User,0,1,0,1,0,0,0 

• Type USER and a comma. 
• Type the user ID and follow with a comma (e.g. "belindar",). 
• This field is for the Case Notebook version GUID, leave it blank and follow with a comma. 
• Type the user's last name (e.g. "Richardson") followed by a comma. 
• Type the user's first name (e.g. "Belinda") followed by a comma. 
• Type a password for the user, followed by a comma. 
• Type a user type (e.g."Reader User") followed by a comma (see "User Types" on page 10 for more information). 
• Type 1 to assign or 0 to restrict administrative privileges (see "User Permissions" on page 11 for more information) and 

follow with a comma. 
• Type 1 to allow or 0 to restrict the ability for the user to replicate cases offline, followed by a comma. 
• Type 1 to assign or 0 to restrict power editor permission, followed by a comma. 
• Type 1 to allow or 0 to restrict the ability for the user to change their password, followed by a comma. 
• Type 1 to require or 0 to not require the user to change their password upon login, followed by a comma. 
• Type 1 to assign or 0 to not assign a Case Notebook seat, followed by a comma. 
• Type 1 to assign or 0 to not assign a RAS seat, followed by a comma. 

Adding Groups 

You can create user groups in the same batch file. Each group contains the following fields: 

GROUP,<groupname>,<userID 1>,<userID 2>,<userID 3> 

For example: 

GROUP,Contract Group,belindar,clairem,jennya 

• Type GROUP and a comma, 
• Type the group name followed by a comma. 
• Type the user IDs for each user followed by a comma. 

IMPORTING USERS AND GROUPS LISTS 

Click the Repository menu, select Import Group/User List, and select the Import from file option to import users and groups from a 
.csv file into Case Notebook Administration. Select the Import from Active Directory option to import users or groups from Active 
Directory (see "Working with Active Directory Authentication" on page 7 for more information). 
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6 Working with Repositories 

A case refers to a collection of content types. A repository refers to the storage location of the case files. Cases in repositories are 
referred to as secure cases. You can open repositories and manage the available repositories list in Case Notebook Administration 
by clicking the Repository menu and selecting Manage. Open and close the current default repository using the Repositories menu 
Close and Open options. 

Adding Repository Servers 
1. Click the Repository menu and select Manage. 
2. Click Add and use one of the following options: 

• Type a server name or IP address into the field provided. 
• Click the Browse button to navigate to and select a repository server. 
• Click Locate to initiate an automated search of your network and automatically populate the list with all available 

repositories. 
3. To set the default repository, select the repository and select Set As Default. 
4. Click Close. 

Removing Repositories from the Available Repositories List 
Click the Repository menu and select Manage. Select a repository to remove from the available repositories list and click Remove. 
Removing a repository from the available repositories list does not delete the repository. It just removes it from the list displayed 
when you click the Repository menu and select Manage. 

Setting the Default Repository 
Click the Repository menu and select Manage. Select a repository to open by default from the available repositories list and click 
Set As Default. To clear the default repository selection, select the default repository from the available repositories list (the 
default repository name is appended with (Default) to indicate the default selection) and click Clear Default. 

Changing the Repository Name 
1. Select a case from the Cases list that resides in the repository for which you want to change the name. 
2. Click the Repository menu and select Change Repository Name. 
3. Type a new name in the Repository Name field and click OK. 

Exporting Repository Registration Settings 
Create a registry .reg file to share with users and allow them to view your repository. Click the Repository menu and select Manage. 
Select the repository from the available repositories list and click Export Settings. Registry settings for the repository, including the 
HKEY, name, alias, host, server, and port information are saved to a .reg file. 

Installing a SQL Server Repository 
Case Notebook Repository uses SQL Server for data storage and retrieval. 

To select an Existing SQL Server for Case Notebook Repository: 

1. Click the Repository menu and select Close to close any open repositories. 
2. Click the Repository menu and select Install SQL Server Repository. 
3. Browse for or enter the SQL Server information in the fields provided. The SQL Server Instance field indicates the location 

to install the repository. This name must match the name selected during installation. 
4. Click Create. 

Importing Repositories from LiveNote Repository 
Import repositories created in previous versions of LiveNote Repository. Importing these repositories adds the repository to the new 
repository. It does not replace the new repository. There is no need to restart the server after updating a repository even if the 
repository exists on a WAN. Importing repositories that contain hundreds or more exhibits, hundreds of case updates, or via a slow 
connection can create slow import times. 
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IMPORTING LIVENOTE REPOSITORY VERSION 9 OR 10 REPOSITORIES 
1. Click the Repository menu and select Import Repository (version 9 or 10). 
2. Click Add and use one of the following options:  

• Type a server name or IP address into the field provided. 
• Click the Browse button to navigate to and select a repository server. 
• Click Locate to initiate an automated search of your network and automatically populate the list with all available 

repositories. 
3. Select the repository to import and click Next.  
4. Login with the administrator user name and password. 
5. Select options from the bottom of the dialog to list the cases, select the cases to include in the import, then click Next to 

import those cases. 
• If you import a case, delete that case, then import that same case using the Previously imported and then deleted 

from Case Notebook administration list option, the case is imported as a new case. 
• If you import a case that exists in Case Notebook, the most recent imported case is appended with a ~1 to indicate 

one is a copy. You can delete the older imported case without affecting the newly imported case. 
6. Select the cases for which you want to build search indexes and click Next. 
7. Browse for a Destination Case Directory and select an option for Open and Offline Cases: 

• Quietly skip any open or offline cases (all notes will be displayed at the end of the process) to skip importing cases 
that are open or offline. 

• Prompt me when an open or offline case is encountered during the upgrade to receive notification when a case you 
intend to upgrade is open or offline. You must be present if you are importing a case using this choice because the 
system pauses and waits for a response. 

• Quietly upgrade open and offline cases (not recommended) to upgrade open and offline cases without being 
notified. This option should only be used if cases are inappropriately flagged as open. 

8. Click Finish. 
• When a transcript cannot be located, a message is displayed and a blank transcript is created in its place to 

indicate the transcript was not imported. 
• When a transcript contains an invalid date, a message is displayed and the import attempts to correct the date. 
• When a lined exhibit cannot be located, a message is displayed and an RTF file is created that includes the text 

"This file was not found when upgrading from an earlier version of the software." 
• Synchronized video information is imported but the import does not validate the existence of the video. 

IMPORTING LIVENOTE REPOSITORY VERSION 8 REPOSITORIES 
1. Click the Repository menu and select Import Repository (version 8). 
2. Browse to and select the sc.nlr file and click Open. 
3. Users and groups that do not exist in the new repository are imported. If case information is included, you are prompted to 

select the cases to import. 
4. Select an owner for the annotations and click OK. 
5. Browse for a Destination Case Directory and click OK. 

Backing Up Repositories 
This is an advanced topic for users with knowledge of working in command line interfaces. The Repository Backup Utility 
(RepBackup.exe) performs repository and case data backups. By default, the Repository Backup Utility is located in the C:\Program 
Files\Westlaw Case Notebook\Administration directory. 

From the command prompt, type RepBackup.exe. The following switches are available: 

• ? - Lists all available commands. 
• server - Specifies the name of the SQL Server instance to act upon. If this parameter is not specified, RepBackup attempts 

to connect to a repository instance named WESTREPOSITORY on the server where Repbackup.exe resides. 
 
If that location contains a server, Repbackup.exe attempts to connect to the server and the default repository name, for 
example, TC3PO\WESTREPOSITORY where TC3PO is the name of the server and WESTREPOSITORY is the name of the 
instance on the server. 
 
If the server contains a server and a SQL instance name, Repbackup.exe attempts to connect to the specified instance on 
the server, for example, TC3PO\Repon2008 where TC3PO is the name of the server and Repon2008 is the instance name. 



Working with Repositories  23 

 
To connect to a default instance of SQLServer, Repbackup.exe requires the following format: Repbackup.exe 
server:TC3PO\MSSQLSERVER where TC3PO is name of the server and MSSQLSERVER is a constant value that must 
specify a default instance. 

• backupdirectory: Specifies the directory for new backup files. The directory must be accessible by the specified SQL Server 
instance and SQL Server must have appropriate permissions in the directory. 
 
If this parameter is not specified, RepBackup stores the backup on the SQL server instance backup directory, for example, 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup\Mon\ where 1 is the SQL server instance ID associated 
with the SQL server instance name. 
 
Network paths do not require quotes. 

• subdirectorymodifiers: Allow you to append the date and time to a backup directory path. Custom text is defined by the 
following flags: 

o -N - Specifies to not append a date or time to the backup directory, for example, C:\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL\Backup\. 

o -D - Specifies to append the current date and time to the backup directory, for example, C:\Repository 
Backup\03_29_2010_13_45_13\ where 03_29_2010 is the date and _13_45_13 is the time. 

Note: If neither flag is specified, the abbreviated name of the current day (Mon, Tue, and so on) is appended to the backup 
path, for example, C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup\Mon\.  If both parameters are 
specified, this flag is ignored. 

To create a directory that does not exist, you can use the subdirectorymodifier option in conjunction with the -D option. If, 
for example, you want to create new directory named Westadmin and append the date and time: Repbackup.exe 
server:\\TC3PO\WESTREPOSITORY backupdirectory:”C:\backup” subdirectorymodifier:”Westadmin” -D 

• dbname: Database name parameter specifying to backup a single case database. 
o -L: List database parameter lists repository databases contained in the SQL server instance and every case in the 

SQL server instance. 
o -E: Echo parameter displays how Repbackup.exe will execute and then executes the command. 
o -e: Displays how Repbackup.exe will execute without actually performing the command. 

Migrating Repositories 

Case Notebook uses Microsoft® SQL Server 2019 Express, a powerful, reliable, and modern SQL for data storage and retrieval. If 
Case Notebook detects that your current repository resides on a SQL Server instance that is outdated, then upon log in, you will be 
prompted to upgrade your repository to the current version of SQL Server for improved security and performance. Click Yes to start 
the migration process immediately, or click No to do this later at your convenience from the Repository > Migrate menu. Note that 
the Repository > Migrate menu item is unavailable (grayed out) when your repositories are up to date.  

If you click Yes, the Repository Migration Destination dialog box is displayed.  

1. Enter the SQL Server Host or click  to browse for the repository server and click OK. Then enter the SQL Server 
Instance of an existing SQL Server for repository migration.  

Note: If you have installed a new SQL server instance for migration, then provide the instance details in the Repository 
Migration dialog box. You can also download the Westlaw Case Notebook Repository Installer from 
https://legal.thomsonreuters.com/en/support/software-downloads/case-notebook/repository or install your own 
instance of Microsoft® SQL Server 2019 or higher.  

Important! If the selected repository already exists on the specified server, a warning message is displayed to inform you 
that if you proceed with the migration to this SQL Server instance, then the existing repository will be replaced resulting 
in data loss. Click Next to proceed, or click Back to return to the Repository Migration dialog box and select a different 
repository.  

2. Select Use Windows Authentication to authenticate if you are a user in Active Directory mode. see "Working with Active 
Directory Authentication" on page 7 for more information. Alternatively, select Use this User, and enter your Username 
and Password.  

https://legal.thomsonreuters.com/en/support/software-downloads/case-notebook/repository
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3. Click Migrate. The Repository Name dialog box is displayed. The current repository name is used for the migrated 
repository. Optionally, you can enter a new name for your migrated repository in Repository Name. 

4. Click Continue to start the repository migration process.  
5. Once the repository migration process is complete, you have the option to proceed with case migration immediately by 

clicking Yes, or you may click No to do this later. It is strongly suggested that you do the case migration as soon as 
possible. See “Migrating Cases” on page 9 for more information.  

Note: When repositories are migrated, Case Notebook users are presented with the Repository Update Check dialog box to inform 
them that the repositories in their list may be out of date, and they have the option to check for updated repositories immediately 
or later when it's convenient for them to do so.  
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7 Working with Reports 

Create reports to audit administrator activities and review user data such as assigned case permissions and offline users.  

To generate a report, click the Report menu and select the type of report you want to create.  

Create the following report types in Case Notebook Administration: 

• Audit: Lists various activities performed by the administrator. See “Creating Audit Reports” on page 25 for detailed 
information.  

• User Tracking: Lists the session logins performed by users, grouped by either the Username or Case name. 
• Case Permissions: Lists permissions assigned to users which enable them to carry out tasks in Case Notebook. See 

“Creating Case Permissions Reports” on page 27 for detailed information.  
• Offline Users: Lists all users that are offline. See “Creating Offline Users Reports” on page 27 for detailed information.  

Note: If there is no user data or administrator activity in Case Administration, reports will not be generated, and an error message 
is displayed.  

Once generated, reports are displayed but not automatically saved. If you exit Case Notebook Administration or close the report 
display without saving, the report is not retained.  

Creating Audit Reports 
Create Audit reports to track the activities performed by administrators.  

To generate an audit report, click the Report menu and select Audit. The report is displayed in a new pop-up window. The title of 
the report is displayed as Audit Report for MMDDYY - MMDDYY.  

The Audit report presents the following data in columns in reverse chronological order, based on the date and time of the event i.e. 
activity performed by the administrator:  

• Date: Date of the activity in MMDDYYYY format. 
• Time: Time of the activity in hh:mmAM/PM format. 
• Event: Type of activity such as user added to a case or group, user deleted from a case or group, group added or deleted, 

case added or deleted, and specific data related to events triggered by use of the Case Mover application. 
• Item Modified: Name of the case, user, or group impacted by the event.  
• Cases Affected: Cases affected by the event. Multiple are separated by a semi-colon. 
• Username: User ID of the administrator that performed the event.  

Note: Use the scroll bars on the bottom and right side of the report to display all data. 

SAVING AUDIT REPORTS 

Once generated, audit reports are displayed but not automatically saved. If you exit Case Notebook Administration or close the 
report display without saving, the report is not retained.  

To save an audit report, click the Save button at the bottom of the report, and choose one of the following formats for the saved 
file: 

• CSV: Comma Separated Values. Use this format to save the values in all fields using a comma as the delimiter. 
• RTF: Rich text format for viewing/editing information in word processing applications. 

The default file name is Audit Report for MMDDYY where MMDDYYYY reflects the date on which the report was generated. 

PRINTING AUDIT REPORTS 

Click the Print button at the bottom of the report.  

Creating User Tracking Reports 
Create User Tracking reports to track the session logins for users grouped by either the Username or Case name.  

To create a User Tracking report: 

1. Click the Report menu and select User Tracking. The User Tracking Report Options pop-up window is displayed. 
Optionally, click the Cases or Users tab on the bottom left of the Case Notebook Administration user interface, select the 
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Case name(s) or Username(s) you want to track, then right-click, and select User Tracking Report from the menu to open 
the User Tracking Report Options pop-up window.  

2. Select one of the following options from the Group Results By drop-down list.  
• Users: Groups and displays the results by Username.  
• Cases: Groups and displays the results by Case name. 

3. Select the date range for the User Tracking report by clicking the calendar icon in Filter by Dates. By default, the first 
date is set to the first day of the month (or the first day of the previous month if today happens to be the first day of the 
month). The second date is set to today's date by default. The date range filter is applied to the date on which the case 
was opened. The date on which a case is closed could be outside of the date range filter and the case may still be 
included in the report. Although selecting a date range is optional, it is recommended in order to limit the size of the User 
Tracking report.  

4. Select the application(s) for which you want to report user tracking from the Application list. This list will display only 
those applications that have been used to open a case. The list will be empty if no applications have been used to open a 
case during the selected date range, and user tracking data has not been created.  
Note: Connections made through RAS append (Remote) to the application title. To view results of content accessed in an 
online case through Content Viewer or Drafting Assistant, select the Case Notebook Content Viewer application.  

5. Select the cases to include in the User Tracking report from the Case list. This list displays all cases in the repository. 
Deleted cases that have audit records are not displayed in the Case list. However, they are included in the User Tracking 
report. 

6. Select the users to include in the User Tracking report from the User list. This list displays all users in the repository. 
Deleted users that have audit records are not displayed in the User list. However, they are included in the User Tracking 
report. 

7. Click OK. The report is displayed in a new pop-up window. 

The title of the report is displayed as Username: NAME (Username) for Group Results By users or Case name: CASE NAME for 
Group Results By cases.  
 
The User Tracking report presents the following data in columns, based on the date and time of the event i.e. session logins 
performed by the user:  

• Username: User ID of the user that performed the session logins in the selected date range.  
• Case name: Name of the case that was opened and closed by the user in the selected date range. Case name 

displayed in the report represents the name of the case at the time when the report was created. If a case was 
renamed and subsequently deleted, multiple Case names (old and new) may be reported with different Case names. 
When a case has been deleted, the report appends (Deleted) in Case name. 

• Login Date: Date of the login activity in MM/DD/YYYY format. 
• Login Time: Time of the login activity in hh:mm:ss AM/PM format.  
• Logout Date: Date of the logout activity in MM/DD/YYYY format. If the case is not closed, this column will display 

'N/A'. The column will display 'Unknown' if the user's session expires for any reason such as inactivity.  
• Logout Time: Time of the logout activity in hh:mm:ss AM/PM format. If the case is not closed, this column will 

display 'N/A'. The column will display 'Unknown' if the user's session expires for any reason such as inactivity.  
• Duration: Length of the session activity in hh:mm:ss format. If the case is not closed, this column will display 

'Ongoing'. The column will display 'Expired' if the user's session expires for any reason such as inactivity.  
• Case Type: Status of the case i.e. Managed/ Unmanaged. It is important to note that the User Tracking report always 

displays the status of the case at the time when the audit record was created, which may be different from the 
current status of the case. Additionally, when a user is replicating Offline cases, every login and logout activity 
(opening and closing the case) is not being tracked. Instead, a single audit record is created to track the replication 
and the report appends (Offline) in Case Type, for example, Unmanaged (Offline). This is an indication that the user 
was replicating. 

• Application: Application that was used to open the case. Connections made through RAS append (Remote) to the 
application name. Content in an online case accessed through Content Viewer or Drafting Assistant show the 
application as Case Notebook Content Viewer.  

• Client Machine: Name of the user's machine.  

Note: Use the scroll bars on the bottom and right side of the report to display all data. 

SAVING USER TRACKING REPORTS 

Once generated, User Tracking reports are displayed but not automatically saved. If you exit Case Notebook Administration or 
close the report display without saving, the report is not retained.  
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To save the User Tracking report, click the Save button at the bottom of the report, and choose one of the following formats for the 
saved file: 

• CSV: Comma Separated Values. Use this format to save the values in all fields using a comma as the delimiter. 
• XML: Extensible Markup Language data file. It is formatted much like an .HTML document, but uses custom tags to 

define objects and the data within each object. XML files can be thought of as a text-based database. 
• HTML: HyperText Markup Language file format used as the basis of a web page. 

The default file name is User Tracking Report for MMDDYY where MMDDYYYY reflects the date on which the report was 
generated. 

PRINTING USER TRACKING REPORTS 

Click the Print button at the bottom of the report.  

Creating Case Permissions Reports 
Create Case Permissions reports to track permissions assigned to users to enable them to carry out additional tasks in Case 
Notebook.  

To create a Case Permissions report, click the Report menu and select Case Permissions. The report is displayed in a new pop-up 
window.  

The report displays a consolidated view of permissions assigned to users who have access to a case for easy viewing or sharing (see 
“About User Types and Permissions” on page 10 for more information). 

PRINTNG CASE PERMISSIONS REPORTS 

Click the Print button at the bottom of the report.  

Creating Offline Users Reports 
Create Offline Users reports to track the count of offline users and their details.  

To create an Offline Users report, click the Report menu and select Offline Users. The report is displayed in a new pop-up window.  

The Offline Users report lists the number of offline users and presents the following user data in columns: 

• Username: User ID of the offline user.  
• First Name: First name of the offline user.  
• Last Name: Last name of the offline user.  
• Date: Date and time at which the user went offline in MMDDYY and hh:mmAM/PM format.  

PRINTING OFFLINE USER REPORTS 

Click the Print button at the bottom of the report.  
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